What's New in Autodesk
Maya

Welcome to What'’s New in Autodesk® Maya® 2015.

This release delivers powerful new toolsets across the board for artists tasked with creating
complex, high-quality assets.

The Bifrost Simulation Platform (page 15) brings new capabilities for simulating and rendering
photorealistic liquids. Additionally, the XGen Arbitrary Primitive Generator (page 16) lets
you use instanced geometry to create and groom hair and fur, as well as create foliage and
vegetation for environments.

Geodesic Voxel Binding (page 9) for skinning offers an innovative method for binding
complex geometry to joint skeletons with ease. Support for Pixar's OpenSubdiv (page 14)
libraries, enhanced Modeling tools, and new UV options (page 11) accelerate performance to
keep you productive.

New support in Viewport 2.0 (page 18) for major effects, rendering and texturing workflows
means you can work in a real-time environment with significant performance gains. Also,
use the new ShaderFX editor (page 19) to create and preview advanced HLSL, GLSL and CgFX
shaders in Viewport 2.0.

For detailed information about new features this release, see:
m  What's New in General (page 2)

m  What's New in Animation (page 6)

m  What's New in Character Animation (page 8)

m  What's New in Modeling (page 10)

m  Whats New in Simulation and Effects (page 15)

m  What's New in Rendering and Render Setup (page 18)
m  What's New in API (page 25)

m  What's New in Help (page 25)



What's New in General

Manipulator plane handles

The Move Tool and Scale Tool manipulators now have plane handles that
let you transform objects along multiple axes.

Multi-Touch support

You can now navigate in Maya using gestural input on supported multi-touch
devices. Maya supports the Wacom Intuos 5, Cintiq 24HD Touch, and Cintiq
Companion, as well as the Apple Magic Trackpad, Magic Mouse, and
multi-touch trackpad in newer model MacBooks.

With the new Multi-Touch Gestures preference enabled in the Interface
preferences, Maya recognizes gestures like 2-finger pinch and swipe, letting
you zoom and pan in the scene.

Walk Tool

The Walk Tool lets you explore your scene from a first-person perspective.
You can create sets and big environments, and then activate the Walk Tool
to move through your scene using game-like navigation controls.

In walk mode (hotkey: Alt + X), you can move through your scene by holding
a mouse button and clicking any of the arrow keys or movement hotkeys
(SWADQE).

2 | Chapter 1 What's New in Autodesk Maya



Improved connection filters in the Hypergraph

Building on the basic connection filters that were introduced in Maya 2014,
new Hypergraph improvements, including a marking menu, constraint
labels, and additional filters, give you greater control over the way connections
are displayed in the Hypergraph.

Node Editor improvements
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You can now customize the list of attributes displayed for each node by creating
a custom attribute list.

Right-click the node and select Edit Custom Attribute List. You can then
use view mode 4 to display your node in this custom attribute view.

In addition, you can now zoom around the mouse cursor by using the mouse
wheel or by using Alt + right-click.
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When graphing an object that is part of an asset, you can choose to graph the
asset; or, to graph the node itself.

Maya Feedback Forums

Visit the Maya feedback forums to suggest and vote for ideas to improve your
experience with Maya. We're listening and we want your input!

We added numerous fixes this release based on your votes in the Small
Annoying Things and Ideas for Maya forums, including:

Texture deformer

Full screen mode for OS X

Improved Eyedropper tool in the Color Chooser
Improved shaderball swatches for mental ray materials
Resizeable Ramp editor

Custom rotate axis

Viewport 2.0 is the default viewport renderer

Viewport 2.0 is now the default renderer for your workspace.

See What's New in Rendering and Render Setup (page 18) for more information.

Alembic and GPU caching additions

New Alembic and GPU cache export options include:

File Format options for saving files to the new Ogawa or HDFS legacy
Alembic formats.

Saving cache file to the Ogawa format provides performance and storage
size improvements.

Multiple Cache Time Ranges for Alembic export, which lets you save
multiple time ranges and sampling rates in the same cache file.

You can use Cache Time Ranges to create a cache file that saves slow
motion sequences at a lower sampling rate, while maintaining high
sampling rates for full-action sequences.

Write Color Sets for Alembic exports, which lets you save motion vector
data for motion blur effects at render time.

Write Face Sets for Alembic exports, which lets you save per-face shading
assignments to cache files.

Saving individual objects in a scene to separate GPU cache files.
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m  Exporting geometry to GPU cache files with the current Smooth Mesh
Preview setting applied.

m  Pipeline Cache > Alembic Cache > Export

m Pipeline Cache > GPU Cache > Export

Full screen mode for Mac OS X

Full screen mode is now supported if you are running Maya on Mac OS X
version 10.7 or later. When full screen mode is enabled, the title bar, menu
bar, and dock are hidden. Select the full screen mode icon or Maya > Enter
Full Screen to maximize Maya's workspace.

Ctrl + click to keep menus visible

There are several menus that list multiple items that you can enable and
disable, for example the Show menu in each panel. You can now Ctrl + click
(Windows and Linux) or Command + click (Mac OS X) to keep the menu open
as you toggle multiple items in the list. To close the menu, click outside the
menu.

Attribute Editor updates

= You can now press enter on the numeric keyboard to complete an edit
and highlight the new attribute value, making it easier to enter new values.

m  New hotkeys give you an alternative to scrollbar navigation in the
Attribute Editor. Quickly pan through long lists of attributes at a normal
speed (Alt + middle-mouse) or an accelerated speed (Ctrl + Alt +
middle-mouse).

Outliner updates

m Streamline your view of objects in the Qutliner using new items in the
Display menu. Select Display > Hide In Outliner > Hide to hide a
node from the Outliner list, then select the object in the scene and use
Display > Hide In Outliner > Unhide to bring it back.

m  New hotkeys give you an alternative to scrollbar navigation in the
Outliner. Quickly pan through long lists of objects at a normal speed (Alt
+ middle-mouse) or an accelerated speed (Ctrl + Alt + middle-mouse) .
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Load or Auto load all plug ins

The Apply To All options added to the Plug-in Manager make it easy to
load all plug-ins for the current session (turn on Loaded), or set all plug-ins
to load automatically the next time you start Maya (turn on Auto load).

Custom axis for the Rotate Tool

A new Custom axis orientation mode has been added to the Rotate Tool,
letting you align the manipulator to a custom axis.

Autodesk® MatchMover™ and Composite software available from Autodesk
Exchange

You can now download MatchMover and Composite from Autodesk Exchange.

What's New in Animation

Grease Pencil updates

Introduced in Maya 2014, the Grease Pencil Tool is now even smoother to
use. Simply start drawing to add a Grease Pencil frame at the current time,
without needing to click the Add Frame button. If your last action was to add
a frame, press the hotkey G to create a new Grease Pencil frame. You can also
now export and import you Grease Pencil Frames to and from other software.
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Custom colors in the Time Slider

The default colors of the Time Slider have been updated to improve the
contrast of the current time Indicator.

In addition, new color settings let you change the default color and opacity
of more elements in the Time Slider. Look for the following new options in
the Animation section of the Window > Settings/Preferences > Color Settings
window:

m Time Slider Current Frame

m Time Slider Current Frame Opacity
m Time Slider Foreground

m Time Slider Background
See Customize colors in the Time Slider.

Bake animation layers

Minor updates in the Bake Simulation options make it easier to control
the layers of your baked animation. The new Baked layers drop-down list
replaces the Delete Baked Channels option, and lets you select from new
options to keep attributes, remove attributes, or clear animation from your
animation layers.

Dynamic attribute performance
New optimizations improve the scalability of dynamic attributes. Operations

including adding or deleting attributes are now faster, even when a large
number of dynamic attributes already exist on a node.

Show buffer curves

Selecting the new option checkbox will turn on the auto-selection of curves.
The default (checkbox selected) behaviour is consistent with previous versions
of Maya.
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What's New in Character Animation

Deformer updates

Texture deformer

Texture deformers let you deform objects with a texture pattern. They are
useful to quickly get the procedural noise of a shape or to preview a
displacement map.

You can now wrap a texture deformer to your mesh. Different direction
methods give you precise control over the deformation. Sample the texture
using the current UV value or by converting each vertex to a sample point.

Shrinkwrap deformer

Project a wrapper object onto the surface of a target object using the new
shrinkwrap deformer (Create Deformers > ShrinkWrap >

O

). Different projection methods give you control over the way each point of
the wrapper is projected onto the target. You can completely engulf the target,
giving the wrapper the same overall shape, or you can simply apply the wrapper
onto the target like a decal. Use the shrinkwrap deformer to attach accessories
to character meshes, retopologize a mesh, or capture detail from a
high-resolution mesh.

Cyclical Constraints in HumanlK

When connecting a prop to an HIK rig, you now have the ability to connect
the prop to one effector using a constraint then have the constraint object as
a source for a second constraint.

m  Support for Cyclical Constraints in HumanIK

Edge and face selection support

You can now add deformers to a selection of edges or faces. Maya automatically
converts edges and faces to vertices when you create a deformer that supports
polygonal objects. For example, select an edge loop, then select Create
Deformers > Cluster to add a cluster to the selected edges.
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Skinning updates

Geodesic Voxel binding

Geodesic Voxel binding is a new smooth skinning method for binding
geometry to joint skeletons that produces quick, high-quality results. The
Geodesic Voxel bind method, unlike other volumetric skinning methods,
handles complex geometry that is not watertight and can contain
non-manifold or overlapping components, which is often the case with
real-world production meshes.

The Geodesic Voxel bind method computes bind weights, by voxelizing the
character skeleton and mesh, which are then applied to existing closed-form
skinning methods to deform the character’s geometry. The resulting weights
are compatible with existing skinning methods in Maya and suitable for use
in game engines.

m  Bind smooth skin with Geodesic Voxel

m  Geodesic Voxel binding

m  Smooth Bind Options

Skinning Update: New Smooth Bind Options

The Smooth skinning Weight Change Percentage setting has been renamed
Required Weight Difference and two new options (Smoothing Iterations
and Obey Max Influences, and ) have been added to the Smooth Skin
Weight settings to give you greater control over your skin binding. See Skin
Smooth Skin Weights Options.

Skinning Update: Reorganized Skin Menu

The Skin menu has been reorganized so that the Weight, Binding, and
Normalizing skinning options are easily available.

NOTE Rigid binding has been removed from the Maya Skin menu to consolidate
commonly-used functionality. If you still need rigid binding, all scripting commands
have been left unchanged and you can emulate Rigid binding using Smooth
binding with 1 influence.
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What's New in Modeling

Quad Draw Tool updates

Introduced as part of the Modeling Toolkit in Maya 2014, the Quad Draw
tool now offers a more streamlined workflow for retopologizing meshes. The
following updates enhance Maya's existing retopology toolset.

Customizable hotkeys: New options in the Modeling ToolKit
preferences let you change the default hotkey mappings to fit your
workflow.

Relax brush: Smooth out your new topology and improve edge flow.

Extend tool: Extend new polygons from edges, borders, edge loops, and
vertices.

Auto-weld components: Automatically weld components that are
moved close together.

Set a reference mesh: Snap the Quad Draw tool to a surface using
Make Live. Make Live replaces the Modeling Toolkit's Other
Surface transform constraint.

Fill holes: Shift-drag over triangular shaped holes in your new topology
to fill them.

Construction history: When construction history is turned on, history
nodes are now created as you work.

GPU cache support: Make Live now supports GPU cache nodes, letting
you retopologize dense assets that contain large data sets.
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UV Texture Editor updates

New options and tools give you greater control when you make selections in
the UV Texture Editor.

Create UV shells: The new Create UV Shell command lets you create
a UV shell from a selection of components.

Display connected edges on UV shells: The new Toggle Shell
Borders command highlights sets of connected edges in different colors,
making it easy to identify edges that are shared.

Tweak UV Tool: Reposition components without switching to the Move
Tool.

Easy component selection: The UV Texture Editor no longer isolates
the current selection. After making a selection, unselected components
remain visible.

Select UV shells: Double-click a face or select the new Shell option from
the UV Texture Editor marking menu to select a UV shell.

Transform components using the Tool Box: You can now use the
Move, Scale, or Rotate tools to transform components.

Hard edge display mode: When hard edges are displayed (Display >
Polygons > Hard Edges), all components are displayed in the UV
Texture Editor, and you can select any component type.

Nudge shells and components: Quickly nudge your selection using
the new nudge controls in the UV Texture Editor toolbar.

Normalize UVs: The new Center on closest tile option lets you scale
UV shells within the closest UV tile.
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Multi-Cut Tool enhancements

More easily cut and slice polygons using the enhanced Multi-Cut tool.
Extensive updates eliminate redundancies and provide you with a single robust
tool that lets you cut, split, and connect polygons. The Multi-Cut Tool
merges the functionality of the now retired Split Polygon Tool and
Interactive Split Tool, and fully integrates the Cut Faces Tool options.
You can now extract or delete faces along a cut, insert edge loops and cuts
with edge flow and subdivisions, and edit in Smooth Mesh Preview mode.

Better Booleans

Boolean operations on polygons now use a new algorithm. While boolean
workflows have not changed, operations are now faster, more stable, and
robust. New boolean options let you select an Intersection Classification
method for operations on open meshes, giving you more control over your
results.

Unfold workflow improvements

ool

New icons in the UV Texture Editor toolbar temporarily apply a shader to
your UV mesh, helping you identify distortion in your UV layout. The checker
pattern shader makes it easy to see if your UVs are spread evenly along the

surface, and the distortion shader lets you spot squashed and stretched UVs.
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Continue to eliminate distortion with the new Unfold3D algorithm. Unfold3D
is a faster, more reliable alternative to the legacy unfold algorithm. In one
unfold operation the new algorithm eliminates degeneracy and distortion,
even at complex corners. Additionally, new optimization options (Edit UVs
> Optimize) provide a more efficient way to relax and untangle your unfolded
UVs.

Work with multi-tiled UV textures in the UV Texture Editor

You can now work with multi-tiled UV textures that have been created in
other applications, including Mudbox, ZBrush, and Mari, in the UV Texture
Editor.

When you load multi-tiled UV textures, the UV Texture Editor automatically
detects the number of tiles and uses the original grid tile layout. Each tile is
labeled with the name of the corresponding texture file.

Modeling Toolkit integration

The Modeling ToolKit is now easier to use with updates that further integrate
it into Maya. The Mesh Editing Tools are now available in Maya's main
menus and marking menus, making it easier to incorporate them into everyday
polygon modeling tasks. Streamlined selection and symmetry workflows let
you enjoy the same functionality and settings in Maya and the Modeling
Toolkit, including:
m Lazy selection: Highlight and select vertices when your cursor isn't
directly above them.

m Topological symmetry: Maya uses the mesh topology to map
components on one side of the mesh to the other, letting you use the new
Topology symmetry mode with deformed meshes or meshes with
overlapping vertices.

= Symmetry: Maya's Reflection setting has been renamed Symmetry
and is now selection-based, letting you perform selection-based polygonal
modeling operations with symmetry.

m  Soft selection: The falloff color is now only drawn on edges, making it
easier to view your mesh when Soft Select is turned on.
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m  Resize a marquee selection: Quickly add and remove components from
an existing marquee selection by holding Tab to temporarily activate Drag
select.

= Dead space selection: When your cursor is outside of your object, you
can now select and tweak edges and vertices.

m Edge ring selection: You can now use the Select tool to select edge
rings.

m Delete components: You can now delete components that are not
selected. Move the cursor over your mesh and press Delete or Backspace
to delete the closest component.

OpenSubdiv support

New support for Pixar's OpenSubdiv libraries lets you work with a high-fidelity
representation of your model. OpenSubdiv is now the default subdivision
method when you preview a smoothed mesh, smooth a mesh ( Mesh >
Smooth), or create a subdiv proxy.

OpenSubdiv is an improved alternative to the legacy Maya Catmull-Clark
subdivision method and takes advantage of parallel GPU and CPU structures,
improving viewport performance for meshes with high subdivision levels.
Additionally, you can turn on Show Displacements in the new
OpenSubdiv Catmull-Clark Controls to visualize displacement maps
interactively without the need to render.

Bevel improvements

Performing a bevel operation on a mesh now produces predictable results.

m  Beveled edges are straight and equal in length, creating better bevels on
concave and convex corners.

m UV texture borders are now maintained during bevel operations.

m  The new Fraction attribute on the polyBevel node produces bevel results
that are not affected by working unit changes.

Mesh menu reorganization

Quickly find commands and tools in Maya's reorganized mesh menus. Menu
items are now categorized and listed alphabetically, making them more
discoverable. Commands are located in the existing Mesh and Edit Mesh
menus, and tools are located in the new Mesh Tools menu.

Delete your preferences for the Mesh Tools menu to appear.
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Convert to perimeter
New options in the Select > Convert Selection menu let you convert a

component selection to a border of edges, UVs, or vertices around the
selection's perimeter.

What's New in Simulation and Effects

Bifrost

Bifrost is a procedural engine that can generate liquid simulations, such as
water and other effects. Use accelerators and colliders to direct the flow and
create splashes and droplets.

Preview the simulation quickly at low resolution using a scratch cache, and
then make a user cache at higher resolution.

Generate a polygon mesh for rendering in mental ray, or render the isosurface
directly. Alternatively, transfer the velocity and vorticity channels to color
sets and export the mesh as an Alembic file.
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XGen

XGen lets you generate curves, spheres and custom geometry on the surface
of Maya polygon meshes. Use XGen geometry instancing to create and groom
hair and fur on characters. Quickly populate large landscapes and
environments, such as grassy savannas, diverse forests, rocky terrains, and
debris trails, using XGen archive geometry.

XGen also includes an interactive grooming brush-set that lets you create and
groom all types of hair and fur as well as shape foliage and vegetation.
m  Use Ptex maps to control the placement of instanced geometry.

m  Useits library of expressions to generate and randomly scale, position, and
color default primitives and custom Alembic-based archive geometry.

m  Export geometry from a Maya scene, then instance it as an XGen archive
object.
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Bullet

Built from the Bullet physics library, the Bullet plug-in lets you use the Bullet
physics engine to create large-scale, highly-realistic dynamic and kinematic
simulations. Bullet simulations can include interacting soft and rigid body
objects. You can create rigid sets from large groups of objects and then
constrain them with the Glue settings. as well as constrained collision objects,
fully integrated into Maya's workflow.

nHair Bend Model

A new Bend Model attribute lets you choose between a bend solving method
for long curly hair and one for generic hair styles. Use Twist Tracking to
maintain twist in long curly hair and for when the base twist of hairs is already
groomed at the start frame. A new Bend Anisotropy attribute for this bend
method lets you control the relative bend resistance in different directions
around the hair. Use Simple for the default nHair bending behavior used in
previous versions of Maya.
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What's New in Rendering and Render Setup

New Viewport 2.0 features

In Maya 2015, Viewport 2.0 supports dynamics and effects, including: Particles
and nParticles, paint effects, Toon, nCloth, nHair and fluids. Tumbling
performance for Particles, nParticles and paint effects is also significantly faster
in Viewport 2.0 than in the Legacy Default Viewport. In addition,
shading nodes such as Projection and Use Background are supported and
run in real-time, allowing for faster feedback.

Performance is also significantly improved for scenes with huge amounts of
geometry or cached animation that does not fit in GPU memory.
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New ShaderFX editor

ShaderFX is a real-time shader editor that allows you to easily create advanced
viewport shaders by connecting different shading nodes. As you create your
shader network, you can visualize the resulting materials real time in Viewport
2.0.

With this feature, artists and programmers can design shaders that match
those of their game engine. Using your game assets and textures inside Maya
is now made easier.
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Viewport 2.0 is the default viewport renderer

Viewport 2.0 is now the default renderer for your workspace.

Render View

The Exposure and Gamma controls in the Render View allow you to
adjust the brightness and midtone contrast of displayed images. The Exposure
and Contrast controls in the ViewColorManager are no longer available.

In addition, the 8-bit integer option for the Render view image format
has been removed. The Render View now always uses 32-bit floating-point
(HDR) mode.
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Simplified workflow for rendering Ptex in mental ray

Model and assets provided by Ptex at
http://ptex.us/samples.html

A new simplified workflow is now available for rendering Ptex in mental ray.
You can connect a Ptex texture to a File node and render it using mental ray
for Maya. In addition, you can adjust the render quality using filter controls.

Progressive rendering with mental ray for Maya

When rendering with mental ray for Maya, you can now enable progressive
rendering for IPR. Progressive rendering begins with a lower sampling rate
and then progressively refines the number of samples towards the final result.
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Improved shaderball swatches for mental ray materials

. mismateriala

You can now visualize reflection and refraction in the shaderball swatches for
mental ray materials. Enable raytracing mode for swatches in the Preferences
window, and the background of the swatch is set to a checkerboard so that
you can easily set different values for refraction and reflection, as well as

predict the final rendered result. The swatches are rendered in a background
thread and do not block UI performance.

Loading multi-tiled UV textures through a single texture node

The UV tiling feature allows you to use a single File texture node to load,
preview and render textures that are composed of multiple images that
correspond to grid tiles in your UV layout.

With this feature, Maya now opens and displays ultra-high resolution textures
produced by 3D painting applications such as Mudbox, and provides a more
effective alternative to using UVsets.

Improved mental ray image based lighting

The Emit Light feature of the mental ray IBL node has been improved to
provide much faster rendering performance as well as better results with a
simpler interface. When working with image based lighting in mental ray,
you can adjust the image quality using a single Quality control slider and
obtain higher quality render results.
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Ambient occlusion pass on the GPU

You can now render the ambient occlusion pass using your GPU when
rendering using mental ray for Maya to experience faster rendering
performance.

To enable this option, select the Use GPU option in the AO pass Attribute
Editor. This functionality is designed for NVidia GPUs that support CUDA.
If you enable this option, but your GPU is not capable of rendering the ambient
occlusion pass, then this pass is computed instead using the CPU.

mental ray mila_material now available

The mental ray mila_material is now available. This material allows you to
easily create physically accurate layered shaders.

mental ray hair shader now available

The mental ray mib_illum_hair_x shader is now available as an alternative to
the default XGen shader.

OpenEXR 2.0 support

Maya can read OpenEXR files that are created by the OpenEXR 2.0 library and
that exercise the version 1.7 feature set.

In addition, mental ray for Maya supports multi-part and multi-layer output
for OpenEXR 2.0. mental ray has the ability to write multiple layers into
separate OpenEXR parts. The names of the OpenEXR parts match the names
of the mental ray frame buffers.

Multi-part EXR files can improve file read performance in applications that
support the reading of OpenEXR 2.0 multi-part files. However, if the
application reading the file does not support this standard, then the file will
not be backwards compatible.

This feature is not compatible with OpenEXR 1.7. Therefore, for backwards
compatibility, mental ray for Maya sets a registry value in the maya.rayrc file
to disable multi-part output by default. To enable multi-part output, remove
this registry value.

FBX now supports DirectX11 shader parameters

The Maya FBX plug-in now supports DirectX11 autodeskUberShader shader
parameters.
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Rendering a subset of hardware shaders with mental ray for Maya

You can render a subset of hardware shaders using the mental ray for Maya
renderer. mental ray for Maya recognizes hardware shaders and treats them
as lambert shaders. Using this feature, you do not need to duplicate materials
and create software versions of your hardware shaders to bake lightmaps.

All shaders of type xPluginHardwareShader are supported.
Baking ambient occlusion in mental ray for Maya

When using a bake set and baking ambient occlusion using mental ray for
Maya, you can enable the Occlusion Deep attribute under the textureBakeSet
node to include transparency in your bake results.

Troubleshooting mental ray for Maya rendering

if you open a pre-Maya 2014 scene that renders using the mental ray for Maya
renderer, your sampling settings are changed to use Unified Sampling. To
render legacy scenes with their previously-saved legacy sampling settings using
the command line renderer, use the new -sampling flag. You can also set the
Unified SamplingQuality using the -unifiedQuality flag.

New resizable Ramp editor for Ramp texture node
The Ramp texture node now features a horizontal ramp that defaults to black
and white. You can easily switch among the rainbow ramp and the black to

white and white to black ramps by selecting its corresponding preset. The
ramp editor can also be expanded into a larger, resizable editor window.

Displaying frustum for non-stereo cameras

You can now display the frustum for non-stereo cameras, in addition to stereo
ones.

Measuring Camera Aperture

The new Camera Aperture (mm) option in the camera's Attribute Editor
lets you measure the camera aperture's width and height in millimeters.

Frame visibility control for image planes

You can now choose to display or hide the frame around image planes.
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mental ray version 3.12

Maya now uses mental ray version 3.12.

What's New in API

Maya 2015 includes many new methods, including: MpxsubSceneOverride
methods that allow you to render multiple instances of a render item at the
same time; MFrameContext methods that allow you to obtain the transparent
depth layer and opaque depth layer in order to use depth-peeling transparency;
MvertexBuffer and MIndexBuffer methods that allow you to more efficiently
set or update the geometry data, and a MDGModifier method that allows you
to delete elements from a multi-plug.

In addition, the Maya .NET API now uses .NET Framework 4.5. You can now
use Microsoft Visual Studio 2012 to compile the .NET examples. You can also
compile the C++ plug-in examples using Visual Studio 2012 Update 4 on
Windows.

What's New in Help

The Maya Help is published in a new format this release as part of the Autodesk
Knowledge Network.

The Autodesk Knowledge Network is your one-stop shop for Support, Learning
and Community resources. Sign in using your Autodesk account and
participate. For more information on creating an account, see About Autodesk
Account.
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